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Abstract: Game-based learning (GBL) has demonstrated significant potential in teaching complex computational 
subjects such as programming, web development, and database management. This research presents SQL Adventure, 
a gamified learning environment that integrates learning analytics (LA) with Bloom’s Taxonomy to scaffold SQL skill 
development. Learning analytics, defined as the systematic measurement, collection, analysis, and reporting of learner 
interaction data, enables performance monitoring, prediction of learning outcomes, and delivery of personalized, data-
driven feedback. SQL Adventure employs narrative-driven tasks, drag-and-drop query construction, adaptive hints, and 
gamification elements (points, badges, and levels) to enhance engagement while capturing fine-grained behavioral data. 
The analytics engine classifies learners based on accuracy, error patterns, and time-on-task, generating adaptive 
learning pathways and external resource recommendations (e.g., NPTEL modules). By aligning SQL exercises with 
Bloom’s cognitive levels and embedding real-time analytics, the system promotes deeper conceptual understanding, 
sustained motivation, and improved problem-solving ability. This study evaluates the platform using the MEEGA+ 
model and learner performance data, contributing a validated design framework for integrating taxonomy-aligned 
pedagogy, gamification mechanics, and data-centric feedback into SQL education.  
Keywords: Bloom’s Taxonomy, Data-Driven Feedback, Educational Technology, Game-Based Learning, Learning 
Analytics, MEEGA+, Student Engagement, SQL Education. 
 
INTRODUCTION 
In the rapidly evolving educational landscape—particularly within technical and computer science 
disciplines—there is a growing demand for instructional methodologies that not only engage learners but 
also facilitate meaningful skill development. [6] Structured Query Language (SQL), a fundamental 
component of database management and application development, remains a core competency for 
aspiring software professionals. However, for many novice For learners, mastering SQL presents 
considerable challenges because of its abstract syntax, steep learning curve, and the limited interactivity 
provided by conventional teaching methods. [1] 
The advent of Industry 4.0 has catalyzed a transformative shift in educational paradigms, giving rise to 
Education 4.0—a learner-centered framework that emphasizes interactivity, personalization, and the 
cultivation of practical, industry-relevant skills. [7] Education 4.0 is tailored to meet the demands of the 
digital age by advocating adaptive learning environments, technology-integrated instruction, and 
competency-based curricula. This paradigm shift demonstrates the value of innovative teaching tools and 
strategies that can bridge the gap between theoretical knowledge and hands-on application, especially in 
domains requiring structured and logical thinking such as SQL programming. [2] 
On the other hand, gamification, the application of game-design elements in non-game educational 
contexts, has become an effective teaching method. Game mechanisms such as challenges, badges, points, 
levels, and real-time feedback can greatly increase learner engagement, motivation, and perseverance. 
Particularly in programming education, gamified methods can reduce entry barriers, simplify complex 
concepts, and foster experiential, iterative learning. [10] 
To complement such engaging learning environments, understanding how students use digital tools is 
largely dependent on learning analytics, or LA. The process of gathering, measuring, and analyzing learner 
data to make decisions that improve learning outcomes is referred to as learning analytics. By identifying 
usage patterns, performance trends, and behavioral indicators, LA enables adaptive interventions and 
personalized learning recommendations, ensuring that no learner is left behind.  
A hierarchical model of cognitive skills used to categorize educational learning objectives is Bloom's 
Taxonomy. There are six cognitive process stages in the taxonomy: Remembering (recalling facts), 
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Understanding (grasping meaning), Applying (using knowledge in real situations), Analyzing (breaking 
down information), Evaluating (making judgments), and Creating (producing original work). Teachers 
can ensure the comprehensive development of cognitive capabilities from a basic to an advanced level by 
planning learning activities according to these stages.  
This study introduces SQL Adventure, a gamified learning environment that teaches SQL to aspiring 
developers using an interactive drag-and-drop interface. The platform includes Bloom's Taxonomy in its 
instructional design, uses progressive levels and point-based systems to gamify learning, and incorporates 
learning analytics to track student accomplishment in real time. Gameplay data is used to generate 
tailored course recommendations to support individualized learning pathways. 
The effectiveness of the platform and the student experience were assessed using feedback gathered from 
the MEEGA+ model, a comprehensive framework for evaluating the impact of educational games. 
MEEGA+ evaluates several characteristics, including perceived utility, learning, motivation, engagement, 
difficulty, and usability. [13] 
 
LITERATURE SURVEY 
1. SQL education has been identified as a challenging domain for novice learners due to the cognitive 
complexity of query formulation and schema reasoning. Taipalus and Seppänen (2020) provide a 
systematic mapping study of SQL education research, outlining persistent issues such as shallow syntactic 
knowledge and limited focus on higher-order cognitive skills. This gap illustrates the importance of 
pedagogically structured interventions that scaffold learners beyond rote memorization. 
2. Rivera and Garden (2021) propose a framework for gamification in student engagement, 
demonstrating how game mechanics such as points, badges, and challenges enhance motivation when 
meaningfully aligned with learning objectives. Gamification is a promising direction that has 
demonstrated an increase in learner engagement and persistence in higher education contexts. In SQL 
education specifically, Trujillo and García-Mireles (2020) conducted an empirical study showing that 
gamification significantly improves both performance and persistence in database courses. Similarly, 
Tahir et al. (2020) evaluated the gamified SQL-Tutor system and reported improved student focus and 
reduced attrition, particularly through the use of badge-based progression. 
3. Trujillo and García-Mireles (2020) demonstrated that gamification led to statistically significant 
improvements in student performance, with learners in the gamified group outperforming those in the 
non-gamified control group. In addition to academic performance, the study also reported higher 
motivation, persistence, and active participation among students using the gamified environment. 
Importantly, gamification sustained engagement and encouraged students to practice more extensively, 
leading to deeper familiarity with SQL query construction. 
4. In parallel, several game-based learning environments have been developed for SQL training. SQL 
Island, for example, embeds learners in a narrative-driven game world where query formulation is tied to 
problem-solving tasks, improving both syntactic and semantic comprehension of SQL. More recently, 
Grange (2024) introduced a novel approach where database exercises are integrated directly into the 
database itself, further enhancing authenticity and practice-based learning. These works point out the 
strengths of educational games but also reveal a lack of systematic alignment with pedagogical taxonomies 
such as Bloom’s. 
5. Finally, learning analytics (LA) and educational data mining (EDM) have emerged as powerful tools 
to complement gamification. Romero and Ventura (2024) provide an updated survey showing how 
analytics can capture fine-grained learner data, identify at-risk students, and enable adaptive interventions. 
When integrated with gamified SQL environments, LA enables not only engagement but also data-driven 
personalization, offering targeted feedback and progression pathways. 
6. Pedagogical perspectives in computing emphasize the importance of structured learning progression. 
Bers (2019) introduced the “Coding as Another Language” (CAL) framework, positioning programming 
not merely as a technical skill but as a new literacy that develops structured thinking from an early age. 
This perspective aligns with Bloom’s Taxonomy, which emphasizes progressive cognitive development 
from remembering to creating. In SQL instruction, adopting such structured pedagogy is critical to help 
learners move beyond rote syntax recall toward deeper query reasoning and problem-solving. 
7. From a broader educational perspective, serious games and gamification have been identified as central 
tools within the Education 4.0 paradigm. Almeida and Simões [9] argue that gamification and serious 
games, when combined with Industry 4.0 technologies, foster adaptive, learner-centered environments 
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that emphasize personalization, interactivity, and practical skill development. Their work emphasizes the 
value of integrating gamification into technology-driven curricula to bridge the gap between theoretical 
knowledge and industry-relevant skills, a principle that strongly aligns with the design of SQL Adventure. 
8. Finally, the evaluation of game-based learning tools is a critical but often underexplored dimension. 
Petri, von Wangenheim, and Borgatto [10] introduced MEEGA+, a validated method for assessing 
educational games in computing education. MEEGA+ evaluates usability, engagement, motivation, 
cognitive impact, and perceived learning, providing a systematic framework for capturing both subjective 
learner experience and objective outcomes. Incorporating such an evaluation model strengthens the 
credibility of gamified environments like SQL Adventure, ensuring that their impact is rigorously 
measured. 
9. Tahir, Mitrović, and Sotardi (2020) investigated the effects of introducing gamification into SQL-
Tutor, an intelligent tutoring system (ITS) widely used for SQL practice. Their study integrated badge-
based achievements and progress indicators into SQL-Tutor to examine how such mechanics affect 
learning outcomes. The authors conducted an empirical evaluation using student interaction data and 
perception surveys. The findings revealed that gamification increased focus, persistence, and motivation, 
encouraging students to engage more actively with SQL tasks. Importantly, these motivational gains were 
achieved without adding extraneous cognitive load, meaning that game elements supported rather than 
distracted from the learning process. However, performance gains in terms of test scores were modest, 
indicating that gamification primarily enhanced practice behaviors rather than direct knowledge 
acquisition. 
10. Game-based learning has been successfully applied to database education through narrative-driven 
environments. Xinogalos and Satratzemi (2022) presented SQL Island, an educational game designed to 
teach SQL concepts by embedding query tasks within a role-playing adventure. Learners progress through 
the game by solving database-related challenges that are integrated into the storyline, thereby linking 
narrative engagement with problem-solving. The study highlighted several benefits of SQL Island: (i) 
students demonstrated improved syntactic accuracy in SQL queries, (ii) the narrative approach increased 
learner motivation and persistence, and (iii) the game’s immersive context encouraged active 
experimentation and exploration of SQL tasks. However, limitations were identified: the system primarily 
addressed syntax-level The program focused on comprehension and provided limited support for 
advancing to higher-order skills, such as query optimization or schema design. 
11. Petri and Giani (2018) validated MEEGA+ through empirical studies across various educational The 
games demonstrate their reliability and adaptability to various computing education scenarios. Unlike ad 
hoc evaluation methods, MEEGA+ provides structured instruments—such as questionnaires and rubrics—
that enable consistent measurement and comparison of game-based learning interventions. 
 
OBJECTIVES 
1. To design and implement a gamified SQL learning environment structured around Bloom’s 
Taxonomy. 
2. To integrate learning analytics into the gamified environment for personalized and adaptive learning. 
3. To evaluate the impact of SQL Adventure on learner performance and engagement. 
 
METHODOLOGY 
This section presents the methodology adopted for the development and evaluation of the proposed 
gamified learning environment. It includes the technology stack, design framework, user interface design, 
interaction flow diagram, level-wise activity details, and a technical user manual to facilitate replicability 
and transparency. 
1.  Design framework 
In response to the gaps listed above, this study introduces SQL Adventure—a gamified, web-based SQL 
learning environment that integrates three key pillars: 
● Gamification mechanics (e.g., points, badges, drag-and-drop interface), 
● Pedagogical alignment with Bloom’s Taxonomy, and 
● Learning analytics instrumentation to monitor and enhance learner progress. 
The game was designed for diploma-level students and tested in a classroom context with second- and 
third-year learners. The game provides a user-friendly drag-and-drop interface for creating SQL queries, 
provides immediate feedback on syntax and logic, awards a certificate upon completion, and provides 
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personalized course recommendations that align with NPTEL content. In addition to direct gameplay, 
the system captures learner interaction data—including number of attempts, error types, and timestamps—
thus supporting both summative evaluation and formative feedback. 
To systematically evaluate the effectiveness of this gamified system, the MEEGA+ model [9] was employed. 
MEGA+ provides a validated framework for assessing educational games, encompassing both player 
experience (usability, satisfaction, relevance, challenge, focused attention) and perceived short-term 
learning. Combining MEEGA+ with learning analytics provides a dual perspective: the learner’s subjective 
experiences and objective behavioral patterns. 
 
2. Technology Stack 

 
Figure 1: Technology Stack 
Figure 1 illustrates the MERN stack components used in our system development: MongoDB (a NoSQL 
database for flexible, scalable data storage), Express.js (a minimal and rapid backend web framework), 
React.js (a component-based frontend library for building dynamic user interfaces), and Node.js (a 
JavaScript runtime environment enabling server-side scripting). The MERN stack allows for end-to-end 
JavaScript development, facilitating seamless data flow and code reusability across client and server 
environments. In this architecture, the frontend view layer is managed by React.js, server-side functions 
and API routing are handled by Express.js and Node.js, and structured application data is stored and 
retrieved by MongoDB. This unified technological stack is ideal for educational platforms and gamified 
learning environments like SQL Adventure, which was created in this study, because it improves 
maintainability, scalability, and rapid prototyping. 
C. User Interface (UI) Overview 

 
Figure 2: Home Page 
In Figure 2, the system begins with the Home Page, which serves as the landing interface, allowing users 
to start the quiz, view instructions, or access learning resources in figure 2. Once the user selects the Start 
Quiz option, the system triggers backend processes to fetch questions from the database and initiate 
session tracking by recording user details, quiz level, and time. 
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Figure 3: Start Quiz 

 
Figure 4: Level-1 Multiple Choice Question 
In figure 4, the user interacts with multiple-choice questions (MCQs) where question objects are 
dynamically loaded from the database, and responses are validated against stored answer keys. User 
selections are logged in the database for performance tracking. 
 

 
Figure 5: Level-3 with drag-and-drop interface 
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In figure 5, As the user progresses to advanced levels, particularly Level-3, the interface introduces a drag-
and-drop environment where learners construct SQL queries using visual blocks. The frontend interface 
dynamically generates queries based on block arrangements, which are then submitted to the backend 
SQL execution engine. If a query is incorrect, the system provides structured error feedback by parsing 
backend execution results and displaying hints to guide the learner in figure 6. For correct queries, the 
backend executes the SQL command on a sample dataset, returning results in JSON format, which are 
rendered in tabular form on the user interface which is shown in figure 7. 

 
Figure 6: Level 3 – Incorrect query 

 
Figure 7: SQL Query result 

 
Figure 8: Result Page with downloadable certificate and Video Recommendation based on Levels 
achieved 
In figure 8, the Result Page aggregates performance data from the database, computes scores, and displays 
the final outcome. The page also integrates a certificate generation engine that creates downloadable 
certificates in PDF format. Additionally, a recommendation engine suggests personalized learning 
resources; for example, beginners may receive NPTEL video recommendations embedded into the results 
dashboard, ensuring a tailored learning experience which is shown in figure 9. 



International Journal of Environmental Sciences 
ISSN: 2229-7359 
Vol. 11 No. 22s, 2025 
https://theaspd.com/index.php 

3160 
 

 
Figure 9: NPTEL Video recommendation based on Beginner Level 
From a technical architecture perspective, the system has a UI Layer for managing interaction, an 
Application Layer for handling business logic like validation and progression, a Database Layer for storing 
questions, answers, and user responses, and a Recommendation Engine that gives learners video resources 
that are appropriate for their level of performance.  This integrated process makes sure that the whole 
learning cycle happens, from testing knowledge through interactive quizzes to executing queries in real 
time, evaluating performance, being certified, and getting help with finding resources. 
End-to-End Technical Flow 
1. UI Layer → Provides interactive interfaces (Home, Quiz Levels, Results). 
2. Application Layer → Handles business logic (quiz progression, validation, feedback, certificate 
generation). 
3. Database Layer → Stores questions, answers, user responses, performance metrics. 
4. Recommendation Engine → Suggests personalized video resources based on achieved levels. 
5. Certificate Engine → Dynamically generates and provides download of completion certificate. 
D. Game Flow Diagram 
The SQL Adventure platform is designed using a layered architecture that integrates gamification, 
Bloom’s Taxonomy progression, and learning analytics. Each layer serves a distinct role while interacting 
with others to create a seamless learning experience. 

Figure 10: Block diagram of game flow 
The figure illustrates the construction of SQL Adventure, showcasing numerous interconnected layers.  
The backend and database layers are in charge of permanently storing data and running queries.  This 
comprises a MongoDB store that keeps track of users' progress, scores, and logs, a question repository for 
storing pre-structured things; and a SQL sandbox (using PostgreSQL/ANSI SQL containers) for running 
queries in a safe space. 
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The Game Engine Layer also takes care of gamification features and progress.  It has a gamification 
module that gives out points, badges, and leaderboards, and a Bloom's Progression Manager that opens 
up new levels of learning based on Bloom's Taxonomy.  A Certificate a generator is also available, which 
may automatically create completion certificates based on how well a learner does. 
The user interaction layer is the front end, which is the part that the learner sees.  It has a login/signup 
module for authentication, a gamified UI that shows multiple-choice questions and drag-and-drop SQL 
interfaces, and a feedback visualizer that displays query results, errors, and hints to help people learn. 
The Learning Analytics Layer supports both adaptive learning and performance monitoring.  It has an 
event logger that keeps track of statistics, errors, and time spent on tasks, as well as an analytics engine 
that sorts students into groups and finds mistakes.  The Recommendation System then proposes other 
resources, such as NPTEL/DBMS videos. The Instructor Dashboard shows how engaged students are, 
how well they are doing, and what they might be getting wrong. 
Lastly, the External Integration Layer makes sure that the system can work with other systems.  It has an 
Export & Reporting Module that makes summaries, certificates, and analytics reports. It also has 
NPTEL/LMS integration, which links the platform to outside learning management systems and video 
resources. 
The system is built using the MERN stack, which includes MongoDB, Express.js, React.js, and Node.js, 
to enable seamless full-stack development. 
The system utilizes a containerized SQL sandbox to ensure the secure and scalable execution of SQL 
queries. 
The Learning Analytics Engine provides real-time and post-hoc analysis of learner performance. 
The Adaptive Recommendation Engine is integrated with external academic content providers, such as 
NPTEL 
 

 
Figure 11: SQL Adventure flow diagram 
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1. User Interaction Layer 
This layer provides learners with a gamified front-end interface, ensuring engagement and accessibility. It 
consists of: 
Login/Signup Module: Handles authentication and initializes learner profiles for progress tracking. 
Gamified UI: Implements multiple-choice quizzes, drag-and-drop SQL query builders, and progress 
indicators, designed to map directly to Bloom’s levels. 
Feedback Visualizer: Displays real-time outputs of queries, highlights syntax/logical errors, and provides 
structured hints (from conceptual nudges to query fragments). 
2. Game Engine Layer 
This layer is the core pedagogical engine, aligning gameplay with Bloom’s Taxonomy and gamification 
mechanics: 
Bloom’s Progression Manager: Unlocks levels progressively (Remember → Understand → Apply → 
Analyze → Evaluate → Create) based on learner performance. 
Gamification Module: Tracks points, assigns badges, updates leaderboards, and dynamically adjusts 
difficulty levels based on learner performance. 
Certificate Generator: Issues personalized digital certificates reflecting Bloom-level mastery, encouraging 
learners to share achievements. 
3. Backend & Database Layer 
This layer provides the execution environment and persistent storage for learner data: 
SQL Sandbox (PostgreSQL/MySQL Containers): Executes learner queries in isolated, secure 
environments to prevent interference across users. 
MongoDB Store: Stores learner profiles, progress logs, scores, and detailed interaction traces (errors, 
retries, timestamps). 
Question Repository: Contains Bloom-aligned question banks, including MCQs, query challenges, and 
schema-based problem sets. 
4. Learning Analytics Layer 
This is the adaptive intelligence of the system, responsible for analyzing learner behavior and providing 
insights: 
Event Logger: Captures granular learner activity (queries attempted, errors made, retries, time on task, 
hint usage). 
Analytics Engine: Uses grouping and sorting methods to classify learners as advanced, average, or slow, 
find misunderstandings, and monitor their progress in mastering the 
Recommendation System: Suggests personalized NPTEL/DBMS resources and adaptive learning 
pathways based on analytics outputs. 
Instructor Dashboard: Provides educators with visual analytics (heatmaps of misconceptions, Bloom-level 
mastery distribution, and engagement metrics). 
5. External Integration Layer 
This layer connects the platform to external ecosystems for extended learning and reporting: 
NPTEL/LMS Integration: Suggests specific learning materials based on the learner's background (for 
example, basic DBMS courses for beginners and advanced indexing for 
Export & Reporting Module: Generates detailed learner reports, analytics exports, and shareable 
certificates. 
Data Flow & Feedback Loops 
Real-time feedback loop: Learner → Query Submission → SQL Sandbox → Feedback Visualizer 
(immediate results). 
Gamification loop: Learner progress → Game Engine → Rewards/Badges → Motivation reinforcement. 
Analytics loop: Interaction logs → Analytics Engine → Recommendations → Adaptive pathways (feeds 
back into Game Engine). 
Instructor loop: Analytics Engine → Dashboard → Instructor intervention → Learner support. 
 
RESULT AND ANALYSIS 
To evaluate the effectiveness of the SQL Adventure game in fostering SQL skills, a mixed-method analysis 
was conducted based on self-reported learner feedback and system-generated learning analytics. The 
results are divided into different parts: (1) learner classification and in-game performance, (2) learner 
profiling prior to gameplay, and (3) evaluation utilizing the MEEGA+ model. 
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A. Pre-Game Learner Profiling 
Participants were asked to fill out an online pre-game questionnaire before starting the game, which was 
intended to gauge their familiarity with SQL and their preferences for online gaming. This stage gave 
crucial background information for understanding later gameplay patterns and learning objectives. 
The study involved sixty-eight diploma-level students in total. Using a 3-point Likert scale (1 being poor, 
2 being average, and 3 being excellent), respondents were asked about their prior understanding of SQL. 
The distribution of answers was as follows: 

 
Figure 12: SQL Proficiency rating on Likert scale 
The following descriptive statistics are derived from the coded Likert responses (Poor = 1, Average = 2, 
Outstanding = 3) Standard Deviation (SD): 0.55, Median: 2.00, and Mean: 2.06. 
According to these findings, the majority of students had a moderate level of self-perceived SQL 
competency when they started the game, whereas a tiny percentage identified as either extremely confident 
or noticeably unprepared. 
Additionally, in response to a binary question about digital gameplay habits, 80.9% (n = 55) of students 
reported that they regularly engage in online or digital games, while 19.1% (n = 13) indicated that they 
do not participate in such activities. This information is relevant for understanding learners' familiarity 
with game-based environments and their responsiveness to game-based instructional formats. 
B. Learner Classification and Game Completion 
All 68 participants successfully completed the SQL Adventure game, which is structured to allow 
progression through a series of Bloom’s-aligned SQL tasks. However, learner performance varied based 
on three key indicators: 
● Number of errors per task 
● Total time spent completing the game 
● Number of tasks skipped or retried 
The system automatically logged these performance metrics and used them to generate learner profiles. 
Upon game completion, the system classified players into three categories: 
● Advanced Learner: Efficient task completion with minimal errors and no skipped challenges. 
● Average Learner: Moderate number of errors and reasonable task completion time. 
● Slow Learner: High error rates, extended completion time, and multiple skipped tasks. 
Based on these classifications, the system issued personalized feedback along with recommendations for 
NPTEL courses that target SQL subtopics where learners exhibited difficulty (e.g., joins, aggregate 
functions, subqueries). The goal of these adaptive recommendations was to promote ongoing, self-paced 
development and expand learning outside of the gaming environment. 
With its foundation in learning analytics, this learner classification technique provides a scalable and 
empirically supported method for tailoring SQL training. It guarantees that the gamified educational 
process strengthens existing knowledge and offers a chance to gain a deeper comprehension of concepts. 
C. Using the MEEGA+ model for evaluation 
The verified MEEGA+ model was used to assess how well students interacted with the SQL Adventure 
game. Especially in computing education, this approach offers a thorough framework for evaluating player 
involvement, usability, cognitive load, emotional response, and perceived learning in educational games. 
[6] Immediately after the game ended, all 68 students completed the post-game MEEGA+ questionnaire. 



International Journal of Environmental Sciences 
ISSN: 2229-7359 
Vol. 11 No. 22s, 2025 
https://theaspd.com/index.php 

3164 
 

 
Dimension Subdimension Item Description Mean Std.Dev Median 

Usability 

Aesthetics 

The game design (interface, graphics, 
colours, cards, boards, etc.) is visually 
appealing and well-balanced. 

4.1 4.0 1.1 

The game was easy to learn, and most 
people would understand it quickly. 

4.125 4.0 1.1 

Learnability 
I needed prior knowledge to play the 
game effectively. 

3.98 4.0 1.1 

Operability 
The game is easy to play, and the rules 
are clear and understandable. 

3.98 4.0 1.2 

Accessibility 

The fonts (size and style) and colours 
used in the game are easy to read and 
meaningful. 

4.03 4.0 1.2 

The game allows customization of 
appearance (fonts/colours) based on 
my preferences. 

3.87 4.0 1.2 

Player’s 
Experience 

User Error 
Protection 

The game helps prevent me from 
making mistakes. 

4.10 4.0 1.1 

If I make a mistake, it is easy to recover 
and continue playing. 

4.09 4.0 1.1 

Confidence 

At first glance, the game seemed easy to 
me. 

4.10 4.0 1.1 

The content and structure of the game 
helped me feel confident in learning. 

4 4.0 1.1 

Challenge 

The game provides new challenges at an 
appropriate pace. 

4.04 4.0 1.1 

The game does not become repetitive or 
monotonous as it progresses. 

3.93 4.0 1.2 

Satisfaction 

I feel satisfied with the things I learned 
from this game. 

4.20 4.1 1.0 

Completing tasks in the game gave me 
a satisfying sense of accomplishment. 

3.89 4.0 1.2 

My personal effort played a key role in 
my progress in the game. 

4.10 4.0 1.1 

I would recommend this game to my 
friends. 

4.04 4.0 1.1 

Social 
Interaction 

The game promotes healthy 
cooperation and/or competition 
among players. 

4.17 5.0 1.2 

Fun 
I had fun playing the game, and certain 
moments (e.g., a surprise element) 
made me smile. 

3.98 4.0 1.2 

Focused 
Attention 

Something interesting at the beginning 
of the game immediately captured my 
attention. 

3.95 4.0 1.2 
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I was so involved in the game that I lost 
track of time and forgot about my 
surroundings. 

3.62 4.0 1.4 

Relevance 

The game contents are relevant to my 
interests. 

3.92 4.0 1.2 

It is clear how the game’s contents 
relate to the course material. 

3.93 4.0 1.1 

Perceived 
Learning 

Overall, the SQL Adventure game is an 
effective teaching method that 
enhances my learning, compared to 
other methods. 

4.04 4.0 1.3 

 
Table 1: MEEGA+ model evaluation 
 

I.DISCUSSION 
The results of objective 1, which investigated the effects of matching SQL learning materials with Bloom's 
Taxonomy in a gamified setting on students' cognitive skill development, show a definite positive benefit. 
With the help of the SQL Adventure platform, learners can advance progressively from remembering 
(MCQs) to comprehension, application, and analysis (drag-and-drop query creation). This alignment 
allows students to improve SQL skills step-by-step, eliminating syntax anxiety while enhancing logical 
thinking and debugging capabilities. This finding is confirmed by student feedback data, which shows 
improved cognitive skill growth was observed throughout Bloom's levels, with an average knowledge gain 
rating of 4.1 out of 5 and consistent "Yes" responses indicating SQL knowledge improvement. 
 
The study demonstrated the usefulness of integrated learning analytics for objective 2, which looked at 
how learning analytics in a gamified SQL environment can offer tailored feedback. SQL Adventure's 
recording of learner retry counts, accuracy rates, and time-on-task data enabled the classification of 
learners into advanced, intermediate, and novice categories. Because of this categorization, the platform 
was able to recommend specific NPTEL-based SQL courses for every learner profile, enabling ongoing, 
personalized learning pathways. Positive qualitative comments and consistently high learner engagement 
ratings (averaging about a 4/5) show that the adaptive learning interventions and tailored 
recommendations were well-received and successful in assisting students in their ongoing development. 
 
According to the findings of objective 3, which examined the effects of involvement in the gamified SQL 
Adventure environment on learners' post-game SQL performance and ongoing learning engagement, the 
platform successfully promoted sustained learning. The organized and feedback-driven nature of the game 
boosted learners' confidence in crafting and debugging SQL queries. While the creation of customized 
certificates upon completion acted as a motivating tool, promoting ongoing engagement, the 
instantaneous presentation of output tables following correct query construction served as reinforcement. 
The feedback data's excellent scores for learning, satisfaction, and engagement attest to SQL Adventure's 
role in enhancing post-game SQL This approach focuses on enhancing performance and motivating 
players to further develop their skills by utilizing the recommended resources. 
 
Overall, the study demonstrates that a gamified SQL learning environment, aligned with Bloom’s 
Taxonomy and supported by learning analytics, can significantly enhance SQL learning outcomes, 
promote cognitive skill development, and sustain learner engagement beyond gameplay. These findings 
validate the design approach adopted in SQL Adventure and reinforce the potential of such environments 
in addressing challenges faced by novice learners in mastering SQL, aligning with the objectives of 
Education 4.0 to foster adaptive, engaging, and effective learning experiences. 
 
FUTURE WORK 
While SQL Adventure effectively enhanced SQL skills and learner engagement, improvements can 
further strengthen its impact. Future work will focus on adding advanced SQL topics, adaptive difficulty 
scaling, and enhanced gamification features (badges, leaderboards) to sustain motivation. UI optimization 
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for mobile access, detailed in-game feedback, and integration with LMS platforms will improve 
accessibility and institutional use. Additionally, longitudinal tracking of learners’ continued learning will 
help measure long-term impact. These enhancements will align SQL Adventure more closely with 
Education 4.0 goals, fostering deeper, personalized, and scalable SQL learning. 
 
CONCLUSION 
According to this study, SQL Adventure, a gamified learning environment that is in line with Bloom's 
Taxonomy and backed by learning analytics, successfully improves learner engagement and SQL skills in 
aspiring developers. Using multiple-choice questions (MCQs) and drag-and-drop query creation, the 
planned path from recollection to analysis promoted systematic cognitive skill development while 
lowering syntax anxiety. Personalized feedback and adaptive NPTEL course recommendations were made 
possible by the incorporation of learning analytics, allowing learners to continue growing at their rate 
even after finishing the game. 
Feedback from 68 students showed strong levels of engagement, satisfaction, and perceived knowledge 
development, demonstrating the platform's ability to effectively handle issues that are frequently 
encountered in SQL instruction. In line with Education 4.0's learner-centered, adaptable, and engaging 
teaching principles, the gameplay of SQL Adventure not only enhanced post-game SQL proficiency but 
also inspired students to pursue additional organized learning. 
To further improve SQL Adventure's scalability and impact, future work will concentrate on gamification 
elements, mobile optimization, adaptive difficulty scaling, and the expansion of advanced content. All 
things considered, this study shows how gamified, data-driven learning environments can revolutionize 
SQL instruction and learning, offering a reproducible framework for developing practical skills in 
technical education. 
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